
 

Welcome to 
 
 
 

 
 
 
 

Introduction to  
Microsoft Excel 2010 

 
 
 
 
 
 



 
2 Introduction to Excel 2010 

What is Microsoft Office Excel 2010? 
 
Microsoft Office Excel is a powerful and easy-to-use spreadsheet application. If 
you are new to Excel and spreadsheets in general, the vast array of features and 
controls can seem quite daunting. However, once we cover the workings of a 
spreadsheet and how to deal with the basics, you will be well on your way to 
becoming an expert in Excel! 
 
Microsoft Office Excel 2010 is the fourteenth version of Microsoft’s spreadsheet 
program. A spreadsheet is essentially a large flexible grid that is used to hold 
information or data. This program does cost money to purchase, however the 
Calcasieu Parish Public Library has Excel as well as other basic Office programs 
installed on all public computers for patron use for free.  
 
Let’s get started by opening Excel. You can do so by double clicking on the  

Excel logo on the desktop. If you have trouble double clicking, just click 
once on the Excel logo then press the ‘Enter’ key on the keyboard. 
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Interacting with Excel 
 
When you open Excel, you will see something like the following image. This is the 
user interface. Let’s go over the basics of what you will see and how to interact 
with the interface. As we progress through the class, we will cover some of these 
items in more detail: 
 

 
 

1 Quick Access 
Toolbar 

As the name implies, the Quick Access Toolbar gives 
you quick access to frequently-used commands. This 
toolbar is completely customizable and can be 
positioned above or below the Ribbon commands. 

2 Tabs Groups of like commands are organized under tab 
names. Click a tab to view the commands in the 
Ribbon. If you are familiar with older versions of 
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Excel, these tabs roughly correspond to the menus 
used in the older interface. 

3 Ribbon Commands Displays tab commands. If you click the different 
tabs, you will see the commands change. Notice that 
some of the commands might be grayed out. This is 
because those commands are only usable under 
certain situations. 
 
You can hover your mouse pointer above a 
command to see the command name. Many 
commands also include a short description. 

 
 

4 Name Box Every cell has a name in the format <ColumnRow>. 
The name of the currently selected cell, called the 
active cell, is shown in the Name Box. You can also 
identify the active cell in the spreadsheet because it 
will be outlined in bold black. In the image on the 
previous page, the active cell is A1.  

5 Formula Bar The Formula Bar allows you to enter data in a cell. 
Data can be alphanumeric, pictures, symbols, or (as 
the name suggests) formulae. 

6 Working Area The data contained in the file will be shown here.  

7 Workbook Tabs Every Excel file is properly referred to as a 
workbook. A workbook can contain one or more 
worksheets, just like an accounting ledger can 
contain one or more pages. Click these tabs to switch 
between the different worksheets. 

8 Status Bar This bar is used to display information about the 
workbook. Any running calculations will be shown 
here. There are also some zoom and view commands 
here which we will explore later. 
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9 Scroll Bars As you grow more accustomed to working with 
Excel, you will no doubt begin to work on larger files. 
Not all of the information in a worksheet will fit on 
the screen, so use these scroll bars to scroll 
horizontally/vertically through the data. 

 
Quick Exercise: Click on any cell in your open spreadsheet. What is the name of 
the cell you clicked on? How did you identify that? 
 
Entering Data 
 
The contents of any cell of a spreadsheet are called data. Data can be words, 
numbers or formulas. We’ll talk later about using formulas. Excel can tell the 
difference between each type and will treat them differently.  
 
Words entered into a cell will automatically align to the left side of the cell.  
Numbers entered into a cell will automatically align to the right side of the cell.  
 
 
 
 
 
 
When typing data into a spreadsheet you can use keyboard buttons to help you 
move from cell to cell. The ‘Tab’ key will take you one cell to the right of the 
active cell. The ‘Enter’ key will take you one cell below the active cell. 
 
Let’s enter a few more lines of data to our spreadsheet 
 
 
 
 
 
 
 
 
 



 
6 Introduction to Excel 2010 

This is a list of bills for a single college student named Bob. Let’s find out his bill 
total for the month. Click on cell B1, keep holding the left mouse button down 
and drag the cursor down to cell B5. We have just highlighted a group of cells, this 
is also known as a range. Your highlighted cells should look like this. 
 
 
 
 
 
 
 
 
While the range of B1-B5 is highlighted, we are going to ask Excel to add them 
together. Look in the ribbon at the Editing group. There you should see a button 
titled ‘AutoSum.’ When you click on it, Excel should automatically place the total 
of our highlighted range into the cell directly underneath the last item in our 
range. 
 
 
 
 
 
 
 
Congratulations! You’ve just added a range of cells together! Bob’s monthly bills 
total $850. Let’s go back and label cell A6 as ‘Total’. 
 
Adjusting Columns and Rows 
 
Excel spreadsheets automatically open with a specific and uniform cell size. We 
can adjust the size of columns and rows to suit our needs.  
 
To change the size of a column, move your cursor over the right border of the 
column header. The cursor should change to something like this:        . Click on 
that border and drag left or right to make the column larger or smaller. 
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Similarly, to change the size of a row, move your cursor over the bottom border 
of the row header. The cursor should change to something like this:        . Click on 
that border and drag up or down to make the row larger or smaller. 
 
You can also change the size of multiple columns or rows by highlighting the 
range of column or row headers, right clicking to pull up a menu of options, and 
selecting column or row width. You can then enter a specific size for this range of 
columns or rows. 
 
Sometimes you have data already entered in your spreadsheet, but the row or 
column isn’t large enough for all of the data to fit. You can manually adjust the 
rows as discussed above, or you can go to the cells group in the ribbon and click 
on Format. When the Format menu is open, you have the option to AutoFit Row 
Height, and to AutoFit Column width. (Be sure that the cell you want to change is 
selected before you go to Format.) 
 
Inserting Rows or Columns 
 
To insert a column, right click on the heading of the column to the left of where 
you want the new column to appear. Click on Insert in the menu that appears. 
 
To insert a row, right click on the heading of the row beneath where you want the 
new one to appear. Click on Insert in the menu that appears. 
  
Exercise: Let’s add a new column and a new row to Bob’s Budget. Right click on 
the header for Column A and then click Insert. Then right click on the header for 
Row 1 and then click Insert. Your new row and column should look like this. 

                               
You can also go to the Cells group in the ribbon to insert rows and columns. 



 
8 Introduction to Excel 2010 

AutoFill 
 
It’s always a good idea to label the data you enter into a spreadsheet. Some labels 
are commonly used in Excel spreadsheets, such as days of the week or months of 
the year. In order to save time, Excel has the ability to AutoFill cells with 
commonly used data lists. Let’s use Bob’s budget as an example. Let’s say that the 
data entered in column C are Bob’s bills for the month of January. Let’s go ahead 
and label that by typing in January in cell C1. 
 
Now, Bob wants to track his monthly budget for 
the whole year. So next month he’ll enter his bills 
for February in column D and so on for the rest of 
the months in the year. Instead of typing out the 
months of the year yourself, Excel can 
automatically enter that information for you.  
 
To AutoFill the rest of the months of the year to 
cells D1 – N1, you will click on the little black square that appears on the bottom 
right corner of our highlighted January cell. Click on that square and drag it across 
until you reach cell N1. As you drag across, Excel should give you a little preview 
of what month will go in each cell, ending with December in cell N1.  
 

                                      
Once you release your mouse button, the months should appear. 
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Exercise: Some of our months do not fit in the columns and are cut off. Adjust the 
size of those columns so that the entire word is displayed. Also, let’s delete 
column A. Your budget should now look like the one below. 
 

          
Notice that deleting column A did not get rid of the column labeled A, but rather 
shifted all the data in our spreadsheet one cell to the left.        
 
Text Wrapping and Centering Data across Columns 
 
Let’s give Bob’s budget a title. Start by adding a row above row 1. Now, type in 
cell B1, Bob’s Budget for the Year. Notice that even though our title is larger than 
the cell we typed it in, you can still see the full text of it. As long as there are no 
entries in subsequent cells like C1 or D1, the text from cell B1 will display.  
 

                                 
 
By default Excel keeps all the data you type into a cell on one line, even if it 
spreads to the next column to be visible. Let’s say you wanted your data to stay 
within the width of the column. Text wrapping makes the data wrap to the next 
line and automatically adjusts the row height to fit. To use text wrapping, look to 
the Alignment group in the ribbon. Make sure the cell you want wrapped is 
selected and click on Wrap Text.  
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Notice that row 1 is now much taller than the other rows, and all the data is 
contained within column B. To undo text wrapping, make sure the correct cell is 
selected and simply click on Wrap Text again to toggle off this feature. 
 
Text wrapping isn’t really the look we want for the title to Bob’s budget, so we’ll 
leave Wrap Text toggled off. Instead, we want to center the title over all the cells 
that contain data. This is called Merge & Center. To do this, highlight the range of 
cells from A1 to M1. While these cells are highlighted, go to the Alignment group 
and click on Merge & Center. Your title should look something like this now. 
 

 
 
 
Formatting Text 
 
If you’ve taken Microsoft Word 2010, you’re probably familiar with the ribbon 
commands to change the size, font and color of text. If not, don’t worry! It’s very 
simple to adjust these features. Make sure that your merged title cell is selected 
and look to the Font group on the ribbon. Let’s change the font size of our title 
from 11 to 18. There are two ways to do this, you can click on the drop box with 
the number in it and change it to 18, or you can click on the Increase Font Size 
button just to the right of the drop box until the number inside reads 18. 
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Notice that Excel automatically adjusted the row height of row 1 to fit our larger 
text. 
 
Using the options in the Font group, let’s change the color of our title to anything 
but black. You choose. Once you’ve set the color, make the font Bold. 
 
Borders 
 
Sometimes having a lot of data on a spreadsheet can make it difficult to see what 
data goes with what labels. Borders are a great way to visually organize the data 
in your spreadsheet. 
 
To add a border, select the cell or group of cells you want the border to appear 
around. In the Font group, click on the down arrow attached to the border button 
to display the different borders you can apply. There are many options to choose 
from, including the line color. 
 
Let’s add a border that separates Bob’s expenses from the totals. Select cells A3 – 
M7. Click on the down arrow attached to the border button, and select Top and 
Thick Bottom Border. Your spreadsheet should now look something like this. 
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Saving your Work & Backstage View 
 
We wouldn’t want Bob to lose his list of bills for the month, so let’s save this 
spreadsheet. Click on the File tab at the top of the ribbon. This will give you 
backstage access to information about your document.  
 
When you are saving a document for the first time, you want to use Save As so 
that you can give your work a File Name. 
 
When you are working in a document that has been previously saved, you can use 
the Save feature to simply save the changes you made to the document. 
 

 
 
The File tab is also where you go to print, open a recently used document, or 
open a brand new document. 
 
Let’s save this document to the Desktop as Bob’s Budget. Click on Save As. In the 
box that appears type in ‘Bob’s Budget’ in the File Name blank. Make sure that 
Desktop is visible in the Save In location. Then click Save.                 
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Bob’s Budget should now appear as a file on the desktop. 
 
Before we leave the Backstage area, let’s discuss Templates for a moment. 
Templates are premade Excel spreadsheets that are available for everyone to use. 
Templates can be useful as a time saver if you do not want to take the trouble to 
set up all the formatting and formulas of a spreadsheet on your own. However it 
can be difficult to find a template that fits the exact type of spreadsheet you 
wanted to create. So be aware that when you use a template, you may have to 
make a few changes to it to make it fit your needs.  
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Number Formats 
 
Let’s go back to Bob’s budget. Notice that even though we’re 
talking about his monthly bills, the numbers entered in this 
spreadsheet give no indication that they represent currency. 
To change this, let’s look at the Number group on the Ribbon. 
Clicking on the drop box in that group gives you many options 
to format the numbers in the spreadsheet.  
 
Let’s make the numbers in the range B3 – B8 currency. 
Highlight the range, then go to the drop box and click on 
Currency. Notice that you numbers now have the $ as well as a 
decimal and two zeros. This is the default currency setting.  
 
Using the Increase or Decrease Decimal option in the Number 
group, we can change how many decimal places appear in our 
range. Let’s get rid of the decimal places. Make sure your range 
is still selected, then click on Decrease Decimal in the Number 
Group. 
 
 
 
Formulas 
 
So far, nearly all of the data we’ve entered into our spreadsheet has been 
numbers or text. We can also enter formulas into a cell in order to perform 

calculations of the data in our spreadsheet. We used a formula earlier 
when we told Excel to add together Bob’s bills for the month, AutoSum. 
This time instead of letting Excel write the formula, we’ll write one of 
our own. 
 
All formulas begin with = 
All formulas begin with = 

All formulas begin with = 
 
It bears repeating because without this step, a formula will never work. The most 
common formulas perform the basic math functions of +,-,*,/.  Select a cell where 
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you want the results of your calculations to display. Then, in the formula bar type 
in =. To add two cells together, type in the name of the first cell + the name of the 
second cell, then hit enter. 
 

                  
Notice in the picture above that cell A1 appears outlined in blue, which matches 
the text of A1 in the formula bar. The same for B1 outlined in green. This is to help 
you keep track of what cells are being calculated. 
 
Once you hit enter the result of your calculation should appear in cell C1. But if 
you look in the formula bar you can see that the formula is displayed. This 
reminds you that this cell was not manually entered, but is the result of this 
calculation. 
 

                  
 
 
 
Let’s write a formula for Bob’s budget. In cell A10, let’s add a new category called 
‘Income’. Let’s make Bob’s income $1000 for the month of January. 
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Let’s write a formula to find out how much surplus income Bob has for the month 
of January. First, let’s label cell A11 as ‘Surplus’. To find out how much extra 
income Bob has all we have to do is subtract his total income from his total bills. 
Which looks like this =B10-B8. Let’s enter that formula into cell B11. 
 

 
 
There are many more formulas and functions available in Excel, which is where 
this program becomes really powerful. Let’s practice writing formulas by filling in 
the next few months of bills and income for Bob’s budget. 
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Further Resources 
 
If you have access to the Internet, you can 
check out the basics of Excel and learn 
about new features by using a command 
in the Backstage menu. 
 
To do this, click File > Help> Getting 
Started:  
  
A new Web page will open in your default 
browser and direct you to articles about 
what’s new and how users of Excel 2003 
(and earlier) can get up to speed with the 
new interface. 
 
The library has books and DVDs on 
Microsoft Excel that you can check out from the library. 
 
We have software tutorials online as well. You can practice with these in the 
library of access them from your home computer.  
 
• Go to calcasieulibrary.org 

• Click on Resources 

• Click on Job & Careers 

• Click on Learning Express Library (if you’re accessing it from home, put in 

your library card number at this point) 

• Click on Popular Software Tutorials 

 
Any questions? 


